
SECRETS OF WINDOWS ACCESSORIES
TIME WAS WHEN AN OPERATING SYSTEM CAME IN ONE PACKAGE AND APPLICA-
tion software came in another. The line between the two was absolute. DOS handled 
drives, ports, screens, and basic housekeeping; applications took care of everything 
else. That line is now breaking down. Today, it is common for operating systems, 
including DR DOS and the most recent release of MS-DOS, to come with small but 
useful applications built right into them. Windows is a leader in this trend.

Upon setup, Windows presents you with a clock, a calculator, a perfectly 
competent word processor, a simple but solid communications program, a drawing 
package, and more. None of these programs is as dazzling as the big commercial 
programs developed for Windows, but they're free! 

Many Windows users are curiously reluctant to dig into these so-called 
applets. Part of this is habit: DOS didn't do it, and applications are not operating 
systems. And part of this is a natural desire to push toward the ultimate in features 
and performance, which is, after all, one of the major attractions of Windows.

Still, overlooking these small applications is a mistake. If you're like most 
Windows users, for example, you'll find Terminal, Windows' built-in communications 
package, to be quite adequate for your communications needs. It does the job-dialing
the phone, handling uploads and downloads-and otherwise stays out of the way. And 
it doesn't take precious disk space away from more important applications, as more 
fully featured Windows communications packages do.

Make the best use of Windows' applets by following the advice in this chapter, 
which includes

Tips for using the Windows Clock

Information on how to get the most out of Write, Windows' built-in word processor

Secrets about the Windows Calculator, including a variety of financial calculations 
that rival spreadsheet capabilities

Strategies for using Calendar

Details on how to take advantage of Cardfile, Windows' utility for managing name, 
address, and phone number information

Tips for using Notepad, including step-by-step instructions on building an activities 
log

Pointers for Paintbrush, Windows' drawing and painting package

Advice on how to navigate Terminal, Windows' telecommunications program

Secrets for making the most of the Macro Recorder

Strategies for using the Character Map

A few nuggets of information on how to win at Windows Solitaire

All of these useful features are found in the Accessories group window, shown 
in Figure 6.1. Don't jump past this chapter to get on to the "real" applications. Take a 
look. There's gold in them thar' applets!



Getting the Time of Day from the Windows 
Clock
The presence of a clock in Windows may seem mundane, until you think about all the
different valuable uses for knowledge of the time. Through this mini-application, 
Windows can become your timepiece in several different forms.

A Timely Icon
Here's a way that you can always see what time it is when you're working in a 
Windows application. From the Program Manager, open the Accessories group 
window and then double-click on the Clock icon. Click on Settings, then on Digital, 
and then select Minimize from the Control menu to reduce the clock display. (To get 
to the Clock's Control menu, click once on the box in the upper-left corner of the 
Clock window.) Or click on the Minimize icon in the Clock's upper-right corner to 
achieve the same result. This places a relatively small, easy-to-read digital clock icon 
at the bottom of your screen, as shown in Figure 6.2.

Easier Clock-Watching
You can use your mouse to drag the clock icon anywhere you like, but it will only be 
visible from another application if the application is not maximized to fill the entire 
screen or you have chosen the Always On Top option (Windows 3.1 only). To access 
this option, open the Clock, access the Clock's Control menu by clicking on the box in 
the upper-left corner of the Clock window or pressing Alt+spacebar, and then click on
Always on Top. (If the option has a check mark to its left, it has already been toggled 
on.) You can then keep the clock minimized or resize it so that it's easier to see but is 
still unobtrusive.

Write Tips
Windows Write is a fairly full-featured word processor. It falls neatly between the 
scratch-pad nature of Notepad and the rich document-management capabilities of 
Microsoft Word. Generally, you would use Notepad for straightforward text work 
related to Windows itself, such as edits of Windows information files. Also, use 
Notepad for quick text you want to print-that is, for notes. In contrast, you would use 
Write for straightforward text work you want to share with others, such as memos or 
simple letters. If your document needs are few, use Write as your day-to-day word 
processor; it is powerful enough to handle that level of activity.

Lines That Don't Disappear
If you try to create lines in your Write document by choosing Underline from the 
Character menu (or pressing Ctrl+U) and then pressing the spacebar repeatedly, the 
lines disappear when you press Enter. To make the underlined spaces stay on the 
screen, you need to add some kind of text to the end of the blank line. For flawless 
lines, add a "hard space" at the end of the line to keep the underline intact. After 
you've entered the number of spaces to create the desired line length, hold down the
Alt key and type 0160 on the numeric keypad; then release the Alt key.

Opt for Optional Hyphens
Like most word processors, Write doesn't break words that are too long to fit on one 
line. Instead, it places the entire word on the next line. If you are using long words, 
this may create big gaps at the end of your lines. Of course, you can add hyphens 
manually and split the word yourself by inserting a carriage return. But this will 
create problems when you edit the document and line lengths change; the word will 
stay hyphenated even if there is room to accommodate it on a single line. To prevent 



this from happening, use optional hyphens. Optional hyphens will only be displayed if
they are needed (at the end of a line); they won't appear when line lengths change. 
To insert an optional hyphen in a Write document, press Ctrl+Shift+hyphen.

Change Margins Every Time
Write sets default margins at 1 1/4 inches for the left and right margins and 1 inch for
the top and bottom margins. If you are accustomed to using different margins, you'll 
have to change them every time you create a document because Write doesn't let 
you set new defaults. You can get around this limitation by creating a template for 
your documents. Change the margins (select Page Layout from the Document menu) 
and make any other formatting changes you'd like in the untitled document that is 
automatically loaded when you start Write.

When you have everything set the way you want, save the file with an easy-
to-remember name such as LETRTEMP.WRI. Then, in Program Manager, edit the 
Program Item Properties for the Write icon. Choose Properties from the Program 
Manager File menu to bring up the Program Item Properties dialog box. In the 
Command Line text box, replace WRITE.EXE with the name of your template .WRI file.
Now each time you run Write this template will be loaded automatically. Of course, 
you have to remember to save the new documents you create under different 
filenames (using the Save As command on the File menu) so that the original 
template stays unchanged.

Special Searches
Like many full-featured word processors, Write can search for special formatting 
characters in your documents. When you select Find or Replace from the Find menu, 
you can specify the following codes to search for and replace formatting in your Write
documents (use the shifted 6 key to get the ^ character):

^w White space (one or more spaces in the document)

^t Tab

^p Paragraph mark

^d A manual page break 

You can also use a question mark (?) as a wildcard character in your searches. So, if 
you're looking for the words "dot" or "doc," you could enter do? in the Find What box.
Likewise, you could find all references to .SYS files by entering ?.SYS.

Being able to find and replace these formatting characters is especially handy 
if you need to strip hard returns from a document that includes line spaces between 
paragraphs. To do this, first replace all cases where there are consecutive paragraph 
marks, ^p^p (the end of a real paragraph), with a series of uncommon characters 
that wouldn't appear elsewhere in the document, such as &88&. Then do a second 
find-and-replace operation where you replace single paragraph marks (^p) with a 
space. Once all of these extraneous paragraph marks are removed, do a final find-
and-replace operation to replace the temporary characters, in this case &88&, with 
regular paragraph marks (^p).

Write Keyboard Shortcuts
You can use the keyboard shortcuts in Table 6.1 in Write.

TABLE 6.1 Write Keyboard Shortcuts



Key   Action

F1 Provides help about Write

Alt+Backspace Undoes previous operation

F3 Repeats the last find

F4 Goes to a page

F5 Turns off font attributes such as bold and italic

Ctrl+Enter Inserts page break

Ctrl+B Selects bold

Ctrl+C Copies selected text to Clipboard

Ctrl+I Selects italic

Ctrl+U Selects underline

Ctrl+V Pastes material from Clipboard

Ctrl+X Cuts selected text to Clipboard

Ctrl+Z Undoes previous operation (including undo operations)

GoTo (5 on the numeric Moves to previous paragraph
keypad with the Num 
Lock key turned off)
+Up Arrow 

GoTo+Down Arrow Moves to next paragraph

GoTo+Left Arrow Moves to previous sentence

GoTo+Right Arrow Moves to next sentence

GoTo+PgUp Moves to previous page

GoTo+PgDn Moves to next page

Write Mouse Shortcuts
You can select entire sections of text in Write by using mouse shortcuts. To select an 
entire line of text, move the mouse pointer to the left of that line and click once. (The
mouse pointer should be an arrow rather than an I-beam.) If you want to extend the 
selection to successive lines, hold down the Shift key while clicking. To select a 
paragraph, double-click in the left margin next to the desired paragraph. If you want 
to extend the selection to successive paragraphs, hold down the Shift key while you 
keep double-clicking. To select the entire document, press the Ctrl key while you click
in the left margin.

Hidden Talents of the Windows Calculator



The Windows Calculator is surprisingly powerful. With a quick mouse click, you can 
gain access to functionality you might expect only from a spreadsheet. In a sense, 
the Calculator is a simple, on-screen financial computer.

Easy Financial Calculations
Following are seven financial calculations you can perform using the scientific view of
the Windows Calculator. The scientific view provides four calculator buttons: the two 
parenthesis keys; the x^y (exponent) key; and the ln (natural logarithm) key. Don't 
worry if you don't remember what an exponent or a logarithm is. This isn't calculus. 
You just need to know where the buttons are so you can punch them.

To get started, open the Accessories program group window and double-click 
on the Calculator icon. Then, to display the scientific view of the Calculator, choose 
the Scientific command from the View menu. Your Calculator should now look like the 
one shown in Figure 6.3. The formulas outlined in the following sections can be 
entered with a mouse or from the keyboard.

Calculate a Loan Payment To calculate a loan payment, you need to know 
the loan amount, interest rate, and number of payments. Suppose, for example, that 
you were thinking about purchasing or refinancing a home. You already know how 
much money you want to borrow. And you can flip through the Sunday paper to 
check out lender rates and terms. That's all you need to calculate a loan payment. 
The formula is

 payment = pv*i/(1-(1- i)^(-n))

where pv equals the loan balance (present value), i equals the interest rate, and n 
equals the number of payments. The calculator keystrokes that you type to solve the 
formula are

 pv * i / ( 1 - ( 1 + i ) x^y ( n  +/- ) ) =

(Note that +/- is a single key located between zero and the decimal point on the 
calculator.)

For example, suppose you want to determine the payments on a $100,000, 
30-year (or 360-month) mortgage with a 12-percent annual (or 1 percent monthly) 
interest rate. You would type the following keystrokes.

 100000 * .01 / ( 1 - ( 1 + .01 ) x^y ( 360 +/- )) =

The Calculator display will show 1028.612596926, which means that the loan 
payment is $1,028.61 when you round to the nearest cent.

Calculate a Loan Balance You can calculate an outstanding loan balance if 
you know the loan payment, the interest rate, and the number of remaining 
payments. You might do this if you were thinking about paying off a car loan and 
wanted to figure out the current balance. The formula is

loan balance = (1-(1+ i)^(-n))/i*pmt

where i equals the interest rate, n equals the number of remaining payments, and 
pmt equals the loan payment. The calculator keystrokes are

 (1 - ( 1 + i ) x^y  ( n +/- ) ) / i * pmt =



So, given a car loan in which the monthly payments are $250 and the loan has
two years (24 months) of payments left at a 12-percent annual interest rate (1 
percent monthly), type these keystrokes:

 ( 1 - ( 1 + .01 ) x^y ( 24 +/- ) )  / .01 * 250 =

The Calculator display will show 5310.846814407, so the loan balance equals 
$5,310.85, rounded to the nearest cent.

Calculate the Future Value of a Lump-Sum Investment You can 
calculate the future value of a lump-sum investment if you know the initial 
investment, the interest rate the investment earns, and the number of years that 
interest is earned. The formula is

future investment value = pv*(1+ i)^n

where pv equals the initial investment, i equals the annual interest rate, and n equals
the number of years that interest is earned.

The Calculator keystrokes that solve this formula are

 pv * ( 1 + i ) x^y n =

For example, if you currently have $10,000 in a mutual fund and expect to 
earn 10 percent interest annually, you would use this formula to estimate the 
account balance in ten years:

 10000 * (1 + .10 ) x^y 10 =

The Calculator display will show 25937.424601, so the future investment 
balance, rounded to the nearest cent, equals $25,937.42. You can also specify the 
interest rate as a monthly interest rate instead of an annual interest rate and use 
months instead of years to describe how long the investment will earn interest.

Calculate the Future Value of a Series of Regular 
Investments You can calculate the future value of a series of equal investments 
given the annual (or monthly) investment amount, the number of annual (or monthly)
investments made, and the annual (or monthly) interest rate. The formula is

future investment value = ((1+ i)^n -1)/ i*pmt

where i equals the annual (or monthly) interest rate, n equals the number of years (or
months) interest is earned and payments are made, and pmt equals the regular 
payment, or investment, amount.

The Calculator keystrokes are

 ( ( 1 + i ) x^y n - 1 ) / i * pmt

For example, if you currently plan to contribute $1,800 a year to your 
Individual Retirement Account, and you expect to earn 12 percent annually, you could
use this formula to calculate the account balance in 20 years:

 ( ( 1 + .12 ) x^y 20 - 1 ) / .12 * 1800 =

After you click on the equal sign, the display shows 129694.3963991, which means 
that the future investment balance, rounded to the nearest dollar, equals $129,694.



Some investments are better when made on a monthly basis rather than 
annually. An IRA illustrates why. Assume that you still plan to contribute $1,800 a 
year, but will make your contributions every month. The formula remains the same, 
but you need to replace the annual figures with figures for $150 a month at 1 percent
a month for 240 months, as shown here:

 ( ( 1 + .01 ) x^y 240 - 1 ) / .01 * 150 =

The result, 148388.3048081, illustrates that a monthly investment of $150 yields 
$148,388 over 20 years. In other words, you would earn over $18,000 more by 
investing monthly rather than annually.

Calculate the Term of a Lump-Sum Investment You can calculate the 
term of an investment, or the years it will take for an investment to reach a specified 
future value, if you know the present investment value, the future investment value, 
and the interest rate the investment will earn. The formula is

term = ln(fv/pv)/ln(1+ i)

where fv equals the future investment value, pv equals the present investment value,
and i is the interest rate.

The Calculator keystrokes that solve this formula are

 ( fv / pv ) ln / ( 1 + i ) ln =

To calculate how long it would take a $50,000 inheritance earning 14-percent 
annual interest to grow to $1 million, type the following:

 ( 1000000 / 50000 ) ln / (1 + .14 ) ln  =

The Calculator display will show 22.86325269477, which means that it will 
take roughly 23 years for a $50,000 inheritance to grow to $1 million if it earns 14 
percent annually. (If you want greater precision, you can also use a monthly interest 
rate. In that case, the term calculated would be in months, not years.)

Calculate the Term of an Annuity You can calculate the term of an 
annuity-that is, the number of years it will take for a series of regular annual 
investments to reach a specified future value-if you know the regular investment 
amount, the future investment value, and the annual interest rate the investments 
will earn. The formula is

term = ln(1+(i*fv)/pmt)/ln(1+i)

where fv equals the future investment value, pmt equals the annuity (regular 
investment amount), and i equals the interest rate.

The Calculator keystrokes you type to solve this formula are

 ( 1 + (i * fv) / pmt ) ln / ( 1 + i ) ln =

For example, to calculate how many years of annual $5,000 contributions to 
your 401(k) it would take for you to become a millionaire if your 401(k) earned a 10-
percent annual return, you would use this formula:

 (1 +  (.10  * 1000000) / 5000 ) ln / ( 1+ .10 )  ln =



The calculator display will show 31.94330809127, which means that it will 
take roughly 32 years for a $5,000 annual 401(k) contribution to grow to $1,000,000 
if the 401(k) earns 10 percent annually. (If you want greater precision, you can use a 
monthly interest rate and then specify the regular investment amounts as monthly 
figures. In that case, the term calculated would be in months rather than years.)

Calculate an Interest Rate You can calculate the interest rate an 
investment earns if you know the present investment value, the future investment 
value, and the number of years (or months) over which interest will be earned. The 
formula for this calculation is

interest rate = (fv/pv)^(1/n) -1

where fv equals the future investment value, pv equals the present investment value,
and n equals the number of years interest will be earned. (Note that this formula 
assumes a one-time investment. For other interest rate calculations-for example, 
those involving a series of payments such as an IRA-the formulas are more complex 
and therefore aren't covered here.)

The Calculator keystrokes you type to solve this formula are

 ( fv / pv ) x^y ( 1 / n ) - 1 =

For example, suppose you can have a balance of $17,000 in your company's 
profit-sharing plan, and a financial planner has suggested that you should have 
$500,000 in retirement savings in 20 years. You could use this interest-rate formula 
to determine what sort of annual return your investment would need to produce:

 ( 500000 / 17000 )  x^y ( 1 / 20 ) - 1 =

The Calculator display will show .1842027196401, which means that your 
$17,000 needs to earn interest at a rate of 18.42 percent to grow to $500,000 in 20 
years. (You could also specify the period of time in months instead of years. In that 
case, the interest rate calculated would be a monthly rate.)

A Calculator Limitation You Should Know About
The Windows Calculator is great for many numeric calculations, but you should know 
about its limitations. It doesn't reliably subtract decimal numbers that are close in 
value to one another, because it has problems rounding them off correctly. For 
example, if your checkbook had a balance of $137.27, and you wrote a check for 
$137.26, the Calculator would give you a balance of $0.009999999999991 instead of
$.01. Of course, you probably wouldn't knowingly use the Calculator to subtract such 
a set of numbers, but if you were doing a series of calculations that included such 
subtraction, your final value might be inaccurate.

Use the Statistics Box to Keep Track of Numbers
Like many calculators, the Windows Calculator lets you keep a running tally of 
numbers with its memory features. When you want to add (or subtract) a number 
from the value in memory, you press the MS (memory store) key. But for more control
over such a tally, use the scientific view's Statistics Box (accessed by clicking on the 
Calculator's Sta key), shown in Figure 6.4. The Statistics Box  Calculator's Sta key lets 
you store numbers in memory separately and visibly. You can place the value for a 
series of equations into the Statistics Box, and then come back to it later when you 
need it.



To verify that you've entered the correct values in a long series of additions 
and subtractions-for example, a checkbook balance-you would open the Statistics 
Box, click on the Ret button, enter the first value in the Calculator, and click on Dat at
the bottom left of the Calculator. The first value will be visible in the Statistics Box. To 
subtract subsequent values, you would enter each successive value, press the Dat 
key, and press the minus key. All the values you entered would remain visible in the 
Statistics Box.

You can also place many values (such as monthly receipts) in the box and 
then use the Calculator's options to sum, average, or calculate the standard deviation
on those values. You can use the following Calculator keys to process the numbers in 
the Statistics Box: S (standard deviation of the numbers), Ave (average of the 
numbers), and Sum (sum of numbers).

In addition, you can load numbers from the Statistics Box back into the 
Calculator by selecting the number in the box and clicking on the LOAD button in the 
Statistics Box.

Calculator Keyboard Shortcuts
Keyboard shortcuts for the Windows Calculator are shown in Table 6.2. 

TABLE 6.2 Calculator Keyboard Shortcuts

Key   Action

F1 Displays help about Calculator

F9 Applies positive or negative sign

comma(,) Inserts decimal point

R Calculates reciprocal of number

Ctrl+C Copies selected material to Clipboard

Ctrl+L Clears memory contents

Ctrl+M Stores value in memory

Ctrl+P Adds displayed number to memory

Ctrl+R Retrieves value from memory

Ctrl+V Pastes selected material from Clipboard

@ Squares the number

Calendar
Personal information managers have long been a kind of application that few users 
felt were important enough to actually go out and buy. Windows skirts this dilemma 
by including with the operating system many basic PIM elements, in particular the 
Calendar. You can use it to manage your schedule in a number of ways and to test 
whether you want or need to move to a more full-featured PIM.

Print Blank Calendar Pages



When you select the Print option from the Calendar's File menu and specify a range 
of dates for which you'd like printed appointment sheets, you'll find out that Calendar
won't print any of the days that are blank. And on the days that it does print, it won't 
print times for which no appointments are scheduled. To trick Calendar into printing 
all of these time slots or all of the blank days within the range, you'll have to type a 
space in each timeline entry so that Calendar thinks there is text describing an 
appointment there.

Personalize Calendar Output
As in many of the Windows Accessories, you can include special information in 
headers and footers in Calendar. By including special symbols in the Header and 
Footer text boxes of the File menu's Page Setup dialog box (Figure 6.5), you can enter
the date, time, filename, and page number on each page, along with any other 
personalized text that you'd like to appear.

By default, Calendar prints the filename as the header and the page number 
as the footer. Use the codes shown here to add information and formatting to your 
headers and footers in Calendar or in other accessories' headers and footers:

&d Current date

&p Page numbers

&f Filename

&l Text justified at the left margin

&r Text justified at the right margin

&c Text centered between the margins

&t Current time

Start Your Day by Previewing Appointments
If you add the Calendar to your Startup Group in Windows 3.1, you won't have to 
remember to check your personal calendar for your daily appointments-it will 
automatically appear first thing. To do this, create an icon for your personal calendar 
in Program Manager and place it in the Startup group. For example, if your calendar 
is named MYCAL.CAL, specify this on the Command Line in the Program Item 
Properties dialog box. Then position the icon in the rightmost position in the Startup 
group window so that it is the last program to load at start-up and remains on your 
screen.

Special Times
If you regularly schedule meetings on the hour or half hour, you'll want to set the 
Calendar's time interval to 30 or 60 minutes. (Open the Day Settings dialog box from 
the Options menu.) But what if you then have a very important 11:15 appointment, 
for which you want to set the alarm? Instead of changing your interval setting to 15 
minutes and making your calendar endlessly long, or recording your appointment in a
less-accurate time slot just because it's available, you can enter the exact time by 
using the Special Time option (press F7 or select Special Time from the Options 
menu). This displays the Special Time dialog box (Figure 6.6), which lets you insert a 
nonstandard time into your calendar. Once it appears as a time slot, you can go 
ahead and record your meeting and set the alarm, just as you would with any 
standard time slot.



Calendar Keyboard Shortcuts
Table 6.3 lists the keyboard shortcuts for Calendar. 

TABLE 6.3 Calendar Keyboard Shortcuts

Key   Action

F1 Displays Calendar Help

F4 Shows the date

F5 Sets and unsets the alarm

F6 Marks a date

F7 Inserts a special time

F8 Views a selected day

F9 Views a month

Ctrl+C Copies material to Clipboard

Ctrl+V Pastes material from Clipboard

Ctrl+X Cuts material to Clipboard

Ctrl+PgUp Shows the previous day or month

Ctrl+PgDown Shows the next day or month

Tab Moves between calendar area and scratch pad at bottom of Calendar screen

Ctrl+Home In day view, moves to starting time

Ctrl+End In day view, moves 12 hours from starting time

Cardfile
Often, when users say they need a database, what they really need is a Rolodex. 
Windows Cardfile provides a solid flat-file record keeper, for free. Anyone who only 
needs to track customers, suppliers, or the like should certainly try Cardfile before 
buying a separate Rolodex-type program.

Fit More Cards on a Printed Page
When you select the Print All option from Cardfile's File menu, you'll get a printout of 
every card in the file. With the default margin settings, only four cards fit on a printed
page. To increase that number to five, select Page Setup from the File menu and 
reduce the top and bottom margins to no more than 0.75 inches. To conserve more 
page space, print the file without headers and footers by deleting the text and 
formatting codes in the Header and Footer sections of the Page Setup dialog box.

Dialing with Cardfile



If you use Cardfile to keep track of phone numbers and addresses, you can have it 
also dial the phone for you. But if you have other numeric information on the card, 
such as a nine-digit zip code, Cardfile may get confused and try dialing that number 
instead. To avoid this problem, set up your cards so that the phone number is the first
set of numbers that Cardfile encounters. To do this on an existing card, place the 
name and phone number on the Cardfile's index line (select Index from the Edit 
menu; you'll see the dialog box shown in Figure 6.7). To add a new card with this 
format, press F7 and, in the Add dialog box, enter the name of the person or 
business, a space, and then the phone number all on the same line; then press OK. 
Now you can fill out the rest of the information in the body of the card: address, 
contact information, or notes.

Quick Card Finds
To quickly get to a Cardfile record, there's a shortcut key combination that eliminates 
the need to use the Search command when your card database has more records 
than you can see on screen at one time. In Windows 3.0, simply press Ctrl+letter key 
to jump to the first card that begins with that letter. In Windows 3.1, this key 
combination is Ctrl+Shift+letter key.

Dial Internal Extensions
You can get Cardfile to dial numbers that contain fewer digits than a regular phone 
number by using hyphens in the empty spaces. Cardfile will treat the extension as a 
standard phone number because it's at least six digits long, but it will ignore the 
hyphens when it actually dials the phone. For example, if you want to be able to dial 
the extensions of co-workers in your office, fill out the index line of their cards as 
follows:

 Fred --6088
 Gayle --6029

If there are other numbers on the card that are six digits or more (such as a zip 
code), you may have to select the phone number with your mouse so that Cardfile 
knows that it is the correct number to dial.

Convert Cards to Text
Put your Cardfile records to use by converting them to ASCII format. For example, say
you want to take your phone and address database and do a mail/merge in Word for 
Windows. You can accomplish this by printing your database directly to a text file. To 
do so, you need to set up your default printer with the Generic/Text Only option. 
Here's the process for doing so in Windows 3.1.

Go into Control Panel and select Printers. Choose Add and select Generic/ Text 
only. Select Install; you may be prompted for a Windows setup disk so that Windows 
can copy the appropriate driver for this printer option to your system. Choose 
Connect and, in the drop-down list of Ports, select File. Finally, select Set as Default.

To create a text file in Cardfile that is as clean as possible, requiring the least 
amount of work for your word processor. You should perform a few formatting 
changes before you print the cards. Select Page Setup from the File menu, delete the 
text in the Header and Footer boxes, and set all the margins to zero, as shown in 
Figure 6.8. This eliminates the default header and footer and gets rid of extra spaces 
in the text file. Finally, select Print All from the File menu; you will be prompted for 
the name of the file to which you want to output. You can now open this file in Word 
for Windows (or any other word processor) and set up your mail merge. Of course, 
there will still be extra spaces and paragraph marks that you'll have to get rid of 
before the file will be usable.



Autodialing Long Numbers in Windows 3.0
Cardfile's Autodial option in Windows 3.0 limits the length of the phone number that 
can be dialed to 14 characters. (Windows 3.1 does not have this limit.) To get around 
this limitation, avoid using unnecessary hyphens or commas to separate groups of 
numbers. For example, 9,678-555-1234 can just as easily be specified as 
96785551234. This way you'll have all 14 spaces for the actual phone number. If the 
number you want to dial requires even more room than that-perhaps you're dialing 
an international number-in the Autodial dialog box consider moving the first six digits 
of the phone number to the Prefix box located below the Phone Number box.

Cardfile Keyboard Shortcuts
Table 6.4 shows keyboard shortcuts for Cardfile.

TABLE 6.4 Cardfile Keyboard Shortcuts

Key  Action

Alt+Backspace Undoes the last command

F1 Displays Cardfile help

F3 Finds the next instance of a specified search string

F4 Goes to a specified search string

F5 Autodials a number on a selected card

F6 Opens an index line on a selected card

F7 Adds a new card

PgUp Goes to previous card

PgDn Goes to next card

Ctrl+Home Goes to first card in stack

Ctrl+End Goes to last card in stack

Notepad Know-How
Notepad is a great place to edit ASCII text, such as the contents of a Windows "read 
me" file, or to jot some quick text you want to print. It doesn't have the power of a 
true word processor (it has terrible file import and export capabilities, for example), 
but then it doesn't have their dangers, either (it won't mistakenly save an ASCII file in
another file format).

Turn On Word Wrap
When you're using Notepad to create lists or reminders for yourself, there's nothing 
more annoying than having the lines of text go on seemingly forever. Fortunately, 
you can just turn on the Word Wrap option on the Edit menu; this option wraps the 
text to fit the current Notepad window. If you shrink or enlarge the window while 
Word Wrap is selected, the text will move to fill the space accordingly.



Add Time and Date to Printed Documents
One of Notepad's niftiest features is its time/date stamp, which lets you enter the 
current time and date in your documents simply by pressing the F5 key. If you use 
Notepad for notes to yourself, this feature is especially handy for keeping track of 
what happened when.

Notepad also gives you another way to add the current date and time to 
printed Notepad documents, by using custom page formatting. From the File menu, 
select Page Setup to display the Page Setup dialog box. In the Header text box, you 
should see the default header code &f, which prints the filename at the top of each 
page. Type &d, &t into the Header box; this will make Notepad include the date and 
time at the top of every page each time the document is printed.

Format Headers and Footers in Notepad
As in Cardfile, Calendar, and Write, you can use formatting codes in your headers and
footers to change their printed appearance. The default header is &f, which prints the
filename at the top of the document. The default footer is Page &p, which prints the 
current page number at the bottom of each page. The code &l aligns header or footer
text on the left, &r aligns text on the right, and &c centers the text. For the &l and &r 
codes to take effect in Notepad, they must be the very first item in the Header or 
Footer text box; otherwise Notepad will ignore them and center text by default.

Create a Log of Your Work Day
If you'd like to keep better track of your time, let Notepad help you by maintaining an
activity log. Open a new file in Notepad and add the word .LOG (you must use capital
letters) at the top of the page. This tells Notepad to stamp the date and time at the 
end of the file every time it is opened. Save the document with an easy-to-remember 
name such as DAYLOG.TXT. To use this log, simply open it whenever you need to 
make an entry and add your activities below the time/date stamp that appears. When
you are ready to record your next activity, select Open again, even though the file is 
already loaded into Notepad. (If you haven't saved your previous additions to the file,
Notepad will ask if you want to do so before displaying the Open dialog box.) Select 
the file; reopening it causes the new time and date to appear.

Notepad Keyboard Shortcuts
Table 6.5 shows the keyboard shortcuts for Notepad. 

TABLE 6.5 Notepad Keyboard Shortcuts

Key  Action

F1 Displays Notepad Help

F3 Finds the next instance of a specified search string

F5 Inserts the time/date stamp at the insertion point

Ctrl+C Copies material to Clipboard

Ctrl+V Pastes material to Clipboard

Ctrl+X Cuts material to Clipboard

Ctrl+Z Undoes previous operation



Paintbrush Pointers
Paintbrush may be the most fully featured of Windows' small applications, and it is 
definitely the most integrated into the environment as a whole. Paintbrush appears 
when you tinker with on-screen colors or edit icons; it's a fundamental element of 
Windows. As a stand-alone application, Paintbrush is strong enough to compete with 
commercial alternatives.

Quick Duplicates
To make copies of an object that you've drawn in Paintbrush, do the following: Select 
the Scissors or Pick tool, both of which are at the top of the Toolbox. The one on the 
left, Scissors, picks irregular shapes; the one on the right, Pick, selects rectangular 
shapes (see Figure 6.9). Outline the object, hold down the Shift key while you click 
once on the object, release the Shift key, and then drag the copy wherever you want 
it. You can repeat this process as many times as you'd like. If you continue to hold 
down the Shift key while you drag the object, you'll draw multiple copies of the 
selected object, as shown in Figure 6.10.

Perfect Lines and Shapes
The Shift key again comes in handy when you are drawing lines, squares, and circles. 
When you select one of these drawing tools, holding down the Shift key while you 
drag with the mouse will produce a line oriented vertically, horizontally, or at a 45-
degree angle; a perfect square (as opposed to a rectangle); or a perfect circle (as 
opposed to an ellipse).

Easy Erasing
As you work on your Paintbrush creation you'll probably find yourself wanting to fine-
tune each change you make. Pressing the Backspace key after you have completed a
task such as drawing a line or adding color calls up an eraser that works just on your 
most recent change. The mouse pointer turns into a square with an x inside it. 
Holding down the left mouse button while you drag the mouse erases whatever part 
of the object you touch. This eraser works only for the most recent addition or change
to the drawing; if you try to erase a part of the drawing that was created before the 
last change, nothing happens. To erase these older parts of the drawing, select the 
Eraser icon in the Toolbox.

More Zoom
If you want to do some detailed work on a section of an image, you can choose the 
Zoom In command from the View menu. You can then select the area you'd like to 
see in detail. But the scope of the area you can zoom in on depends on the size of the
overall image. (To check the size of the image, select Image Attributes from the 
Options menu.) If the image is very small, the box that appears to let you select the 
zoom-in area is also very small. If this doesn't cover enough ground for you, copy the 
image to a larger size and then zoom in on it.

Save the image you are working on just in case you make some changes that 
you don't like. Now select the entire image with the Pick tool, select Copy from the 
Edit menu, and choose New from the File menu. Before pasting the copy of the 
image, set the Image Attributes (found on the Options menu) to a larger width and 
height than the original drawing. When you paste in the image, it will appear to be 
the same size, but when you select Zoom In, the selection box is larger. You can now 
zoom in on the entire area that you want, which enables you to make the desired 
changes.

To return the image to its original size, copy it again and set the Image 
Attributes of this third drawing to match those of the original. This third drawing, 



which has your changes and has the same width and height dimensions as the 
original, is the file you'll want to save. The original and interim copy may be deleted.

Special Text Effects
When you add text to your Paintbrush creations you'll notice the choices Outline and 
Shadow on the Text menu. If you select one of these options and start typing text, 
you may not see these special effects. If you're using a white background, they won't 
appear as outlined or shadowed because white is the color used to create these 
effects. (Note that you cannot change this color.) But any other background color, 
with a contrasting foreground color used for the text, will give you outlined or 
shadowed text, as shown in Figure 6.11. To change the background color on a new 
drawing, click with the right mouse button on the color you want, and then select File,
New. To change the background on an existing drawing, use the Paint Roller tool.

Paintbrush Keyboard Shortcuts
Table 6.6 shows keyboard shortcuts for use in Paintbrush.

TABLE 6.6 Paintbrush Keyboard Shortcuts

Key Action

F1 Displays Paintbrush Help

Ins Alternative to clicking the left mouse button

Del Alternative to clicking the right mouse button

F9+Ins Alternative to double-clicking the left mouse button

F9+Del Alternative to double-clicking the right mouse button

Shift+Up Arrow, Moves up or down one line
Shift+Down Arrow 

Home Scrolls to top of work area

End Scrolls to end of work area

Shift+Home Scrolls to left edge of work area

Shift+End Scrolls to right edge of work area

Shift+PgUp Scrolls left one screen

Shift+PgDn Scrolls right one screen

Tab Moves among Toolbox, Linesize box, Palette, and drawing area

Shift+Tab Moves in reverse order among Toolbox, Linesize box, Palette, and drawing
area

Ctrl+B Boldfaces selected text

Ctrl+C Copies selected item to the Clipboard



Ctrl+I Italicizes selected text

Ctrl+N Zooms in on the screen

Ctrl+O Zooms out from the screen

Ctrl+P Enlarges drawing to fill the entire screen

Ctrl+S Saves drawing

Ctrl+U Underlines selected text

Ctrl+V Pastes material from Clipboard

Ctrl+X Cuts material to Clipboard

Ctrl+Z Undoes previous operation

Tapping into Terminal
Terminal has its limits, but if what you need is reliable dial-up and connection, this 
application is all you require. I actually use Terminal to dial MCI mail on the road from 
my notebook. Why take up valuable disk space when a perfectly adequate program is
already part of Windows?

Print Selected Terminal Text
Terminal offers you a few options for capturing the contents of a communications 
session. You can enable Printer Echo, which sends all the information from your 
screen to the printer; you can save incoming text to a file; and you can save the 
buffer contents by copying it to the Clipboard. All of these methods work well, but if 
you only want to print (and not save) certain text selections, you can copy the 
information directly from the screen (or the buffer) to the Clipboard. Use the mouse 
to highlight the text you want, and copy it to the Clipboard. Then paste the copied 
text into Notepad or Write. At this point, you can print the text.

Increase the Buffer Size
The buffer in Terminal is a holding tank for what transpires during a communications 
session. Everything that you see on your screen is stored in this buffer. But because 
buffers can hold only a limited amount of information, the most recent information 
from your session replaces the old. A buffer can be an extremely valuable resource 
because it allows you to see where you've been. If a screenful of information scrolls 
by too fast, you can scroll through the buffer to see what you missed.

You can also use a buffer to capture information from your session that you 
want to save or print. You can select the buffer contents and copy them to the 
Clipboard, where you can save the data as a file or send it to the printer. If you 
regularly copy the buffer contents to the Clipboard, paste them into a document file 
(for instance, in Write), and then clear them before resuming your session, you have 
a way of recording and saving the entire session, no matter how many lines of text it 
contains. Since it has all these valuable uses, you can see why you'd want the buffer 
to be as large as possible. The default size is only 100 lines. To change the buffer size
to the maximum value of 399 lines (or less), choose Terminal Preferences from the 
Settings menu and change the number in the Buffer Lines text box. Any number from
25 to 399 is a valid setting.



Turn Off Call Waiting
If you share one telephone line for voice and data purposes, call waiting can cause 
connection problems when your computer and modem are using the phone line. Of 
course, you don't want to give up your call waiting, and fortunately you don't need to.
You can temporarily turn off call waiting for a call by entering a code before you dial 
the phone number.

Have Terminal do this automatically each time you dial out by adding the code
as a regular dialing prefix. To do so, select Modem Commands from the Settings 
menu and add the numeric code in the Dial Prefix box (see Figure 6.12). The default 
Prefix setting is ATDT, so, for example, you would type *70 after that to create 
ATDT*70. In many calling areas, *70 is the code to turn off call waiting. If this doesn't 
work, check with your phone service to find out which code you must use.

Work Around Noisy Phone Lines
If you consistently have a problem with noisy phone lines when you are using 
Terminal, it may help to lower the baud rate that you are using. Try dropping down to 
the next lowest setting and see if the condition of the phone lines improves. To do so,
choose Communications from the Settings menu and choose a lower baud rate. For 
example, if you are currently communicating at 9600 baud, try 4800 and see if that 
helps.

Run Terminal Maximized
When you start Terminal, you'll notice that it doesn't automatically run maximized. 
However, if you'd like it to start maximized so that you can see more buffer lines, you
can edit your WIN.INI file and tell it to do so. Open WIN.INI in SYSEDIT or a text editor 
and find the [Terminal] section. Type the line Maximized=1 at the bottom of this 
section, and then save your changes. For this change to take effect, you have to exit 
and then restart Windows.

Terminal Keyboard Shortcuts
The keyboard shortcuts for Terminal are shown in Table 6.7.

TABLE 6.7 Terminal Keyboard Shortcuts

Key  Action

F1 Displays Terminal Help

Ctrl+C Copies material to Clipboard

Ctrl+V Pastes material from Clipboard

Ctrl+Ins Copies selected text to Clipboard

Shift+Ins Sends Clipboard contents to remote system

Ctrl+Shift+Ins Sends selected text to remote system

Make the Most of the Macro Recorder
Windows' Macro Recorder took a lot of heat in the early days as one of the least well-
developed parts of the environment. It seemed to be the component written last and 
most hastily. Even in Windows 3.1 the recorder is less than spectacular, but it can be 
quite useful if you are aware of its quirks and limitations. These tips provide direct 



benefits from Recorder and will help you become familiar with how to use the 
program effectively.

Avoid the Mouse
When using Windows' Macro Recorder, you should always use keyboard commands, 
not mouse clicks. Mouse clicks can be recorded, but they may not play back correctly
because their position is recorded relative to the upper-left corner of the window. 
Since your programs' windows aren't always the same size, the actions you take with 
the mouse in one window won't always achieve the same effect when played back in 
another window. To make sure that the mouse isn't recorded for the current macro, 
select Macro, Record and choose the Ignore Mouse setting in the Record Mouse drop-
down list box. To avoid recording mouse actions for any macro, select Options, 
Preferences and then Ignore Mouse in the Record Mouse box (see Figure 6.13).

Use Macros to Resize Windows
Almost any task you repeat is a candidate for a Recorder macro. A good test of 
Recorder's power is to replicate the shortcuts, found in earlier versions of Windows, 
that maximize, minimize, and restore a window (Alt+F10, Alt+F9, and Alt+F5, 
respectively). While these handy keyboard shortcuts were not included in Windows 
3.0 or 3.1, with the help of Recorder you can use the following instructions to restore 
them to your Windows system.

Open the Recorder and activate any program whose window can be 
maximized, such as Program Manager. Then press Alt+Tab as many times as 
necessary, until Recorder becomes the active window again. Give the macro a name 
that describes what it does. In the Shortcut Key area of the Record Macro dialog box, 
put an x in the Alt check box (remove the x from the other check boxes, if necessary) 
and press F10. (Or, if you prefer, click on the downward-pointing arrow and choose 
F10 from the drop-down list.) The shortcut key for your macro is now set to Alt+F10.

In the To drop-down list box in the Playback section of the dialog box, choose 
Any Application. This step is important. By default, Recorder macros operate only on 
the applications in which they are recorded. Because you want your maximize macro 
to affect whatever window is active when you run it, this step changes the default 
playback option to Any Application.

With the dialog box filled out, click on the Start button. Recorder shrinks to a 
blinking icon and returns you to the application you were in before you activated 
Recorder. The blinking icon is your signal that the tape is running. Everything you do 
now will be saved for posterity.

Press Alt+spacebar, x to maximize whatever application you're now in. 
(Remember to use keyboard techniques.) Then press Ctrl+Break to turn off the 
Recorder. Recorder responds with another dialog box. Choose Save Macro and click 
on OK; you now have a keyboard shortcut for maximizing application windows. Try 
activating an unmaximized window and pressing Alt+F10 just to make sure your 
macro is working as it should.

You can follow the same procedure to create minimize and restore macros. To 
make your macros available for future Windows sessions, return to Recorder, choose 
the File menu's Save command, and give the file a name such as SYS-MAC. (Recorder
will assign it the extension .REC.) You can then make this macro file a regular resident
of your Windows desktop by adding the line

 Load=SYS-MAC.REC

to your WIN.INI file. With this command in WIN.INI, your macros will be available 
during each work session.



View Macros
In Recorder you cannot edit previously recorded macros, as you can in many 
applications such as Microsoft Word for Windows. However, you can review their 
contents. If a macro isn't working quite right, this will give you a way to study the 
recorded events and debug the macro. To peek at a macro's contents, start the 
Recorder, select Open from the File menu, and specify the macro that you want to 
look at. Hold down the Shift key while choosing Properties from the Macro menu. 
You'll now see a dialog box that shows all the actions contained in the macro.

Start Recorder Macros from Other Applications
You can call a Windows Recorder macro from within a Windows application or when 
you start Windows by using Recorder's command-line shortcut keys. In the following 
example, STARTUP.REC is the name of the Recorder macro; Ctrl+Shift+Alt+Home is 
the hotkey sequence that invokes STARTUP.REC.

 WIN RECORDER-H^+%HOME STARTUP

This command will load Windows, load Recorder, and fire up the STARTUP macro. The 
-H portion tells Recorder that a macro shortcut-key sequence follows. The ^+%HOME
portion tells Recorder which shortcut-key macro to execute (Recorder cares only 
about the shortcut-key sequence assigned to the macro).

On the command line, Recorder requires you to use special symbols when 
specifying the Ctrl, Shift, and Alt keys: ^ specifies Ctrl, + specifies Shift, and % 
specifies Alt. For example, %END specifies Alt+End. Therefore, ^+%HOME specifies 
Ctrl+Shift+Alt+Home.

Assign Macros to Icons
You can assign an icon to any macro that you create with Recorder; then you can run 
the macro simply by double-clicking on its icon. You can do this because of the 
command-line shortcut keys that Recorder recognizes. When you are creating a new 
program item for the macro, use the following syntax to specify the command line in 
the Program Item Properties dialog box:

 RECORDER.EXE [-H shortcut key] [filename.rec]

Use the special symbols (^, +, and %) in place of the Ctrl, Shift, and Alt keys, 
respectively.

Create Demonstrations with Macro Recorder
Teach your employees how to take full advantage of a Windows application by 
creating a customized demonstration that profiles critical Windows program features. 
This is only one potential use for the Macro Recorder. Because you can use the Macro 
Recorder to automate virtually all Windows operations-including keyboard commands
and mouse procedures-it's the perfect tool for setting up personalized, real-world 
demos. When new employees come on board, introduce them to your PC operations 
by replaying a Recorder macro. Voilà! an instant demonstration.

Assign Macros for Key Combinations
If there are function keys that you seldom use-for example, the F11 or F12 key-put 
them to work by assigning a Recorder macro to them. One convenient option is to 
assign a two-key combination to them. For example, if you find it awkward to press 
Ctrl+Esc when you want to call up Task Manager, assign that key combination to a 
function key for a command that's easy to execute every time.



Stop Recording Quickly
If you need to stop or pause while recording a macro, press Ctrl+Break. This 
keystroke combination will suspend the replaying of a Recorder macro.

Use Recorder to Assign Shortcut Keys in Windows 3.0
In Windows 3.1, you can define a shortcut key for each icon. If a shortcut key is 
assigned to an application, you can quickly start the application without hunting 
down the icon and then double-clicking it. To achieve this same result in Windows 3.0,
you can use the Recorder to create a macro that launches a specific application-for 
example, Cardfile. If you already have a file of macros that you use every day, open 
that file so you can add this new macro to it.

A macro is worthless if you can't remember the keystrokes to activate it, so 
it's a good idea to use mnemonically significant shortcuts for each application 
launcher you create. For starting Cardfile, you can use Ctrl+Shift+C. Choose the 
Macro command in the Record menu, fill out a name for the macro, and specify the 
shortcut key you want to use. Click the Start button. Now hold down the Alt key and 
press Tab as many times as necessary to activate the Program Manager window. If 
Program Manager is active already, hold down Alt anyway and tab through all the 
programs on your desktop until you come back to Program Manager. (Don't worry if 
you go around more than once; Recorder cares only about where you end up.)

In Program Manager, press Alt+F, R to execute the File Run command. 
(Remember to use keyboard rather than mouse techniques when recording a macro.) 
Fill out the dialog box by typing cardfile in the Command Line text box and press 
Enter (the keyboard equivalent of clicking on OK). You can also include the name of a 
data file (including its full path) to load into Cardfile if you wish. In a moment, Cardfile
appears. As a final (optional) step, press Alt+spacebar, x to maximize Cardfile. Now 
press Ctrl+Break to stop the recording. In the dialog box that appears, choose Save 
Macro and click OK. Now pressing the shortcut key should automatically start 
Cardfile.

Because you can't predict where icons will be at playback time, in the 
recording you must activate Program Manager and launch Cardfile with keystrokes 
rather than mouse actions. And because the Program Manager item in the Task List 
window isn't located in any predictable position, you can't activate Program Manager 
by pressing Ctrl+Esc and scrolling through the list. Finally, if Program Manager is 
already the current window when you begin recording, you must cycle around once to
actively select it; unless you do this, your macro will fail if Program Manager is 
minimized at playback time.

Character Map
Being able to see what you get makes choices so much simpler. In the case of 
graphical characters, that has not often been possible in the past. You had to type a 
complex key sequence to get an ANSI or high ASCII character, and even then might 
see nothing but an embedded code on your screen. Windows 3.1 provides a 
Character Map that lets you see all the characters your typefaces provide. That's 
straightforward, but a benefit nonetheless. Character Map is also discussed in 
Chapter 8 under font housekeeping.

Easy Extended Characters
Character Map allows you to easily incorporate special characters into your 
documents, such as extended ANSI characters, trademark symbols, and foreign 
language characters. To locate a specific character, launch Character Map and view 
the characters available for each font. It's best to use a character from the same 



typeface as the rest of your document, but if you can't find the desired character 
there, try other typefaces, especially Symbol or Wingdings. If you have a hard time 
discerning what each character is because it's so small in the map, move the mouse 
pointer to it and hold down the left mouse button. A close-up of the character will pop
up. Once you've located the character, click on it to select it. It should appear in the 
Character to Copy text box above the map. Select Copy to place it on the Clipboard. 
Then switch back to your document, position the cursor where you want the 
character to appear, and select Paste; it's as simple as that.

If the character doesn't appear after you've pasted it, make sure you have its 
corresponding font selected in your document: Paste may not automatically switch to
the font that the special character requires if it's different from the one you're 
currently using. Once the character is pasted into your document, you can format it 
as italic, bold, and so on, if you like.

Multimedia Applets
Windows 3.1 adds two applets that indicate the impact of the multimedia future on 
the Windows environment: Sound Recorder and Media Player. Both are rather sketchy
programs, more demonstration projects than truly useful applications. However, they 
do perform real work, and if you are multimedia-minded, they are a good place to 
begin familiarizing yourself with the new world of computer-controlled sound and 
video.

Play .WAV Files All the Way Through
If you are using Microsoft's PC speaker driver to play .WAV files on a PC without a 
sound board, the .WAV files that you play in Sound Recorder may not play all the way 
through. To fix this, change the speaker's Drivers settings in the Control Panel. Select 
your speaker driver and move the scroll bar for the Seconds to Limit Playback option 
all the way to the right.

Sound Recorder Keyboard Shortcuts
The keyboard shortcuts for the Sound Recorder are shown in Table 6.8. 

TABLE 6.8 Sound Recorder Keyboard Shortcuts

Key  Action

Tab Moves among buttons

Shift+Tab Moves among buttons in the reverse direction

PgUp Moves backward one second

PgDn Moves forward one second

Home Moves to beginning of sound

End Moves to end of sound

Solitaire Secrets
Even Windows games have little, hidden aspects. So that you can be sophisticated 
even when you are being frivolous, here are some tips on Windows Solitaire. Be a hit 
at parties, amaze your friends!



Surprise Yourself with Random Card Backs
The first time that you play the Solitaire game included with Windows, the card back 
option that is shown is selected randomly. This means that each time you play you'll 
get to use a different deck of cards. But if you ever select a deck yourself you'll lose 
this option, and there's no setting for it in the Select Card Back box (displayed by 
selecting Game, Deck). 

To revert to using random decks in Windows 3.1, edit the SOL.INI file that 
contains setting information for Solitaire. It's located in the Windows directory. Open 
the file in Notepad or another text editor and find the entry that says BACKS=. Delete
this entry and then save the file. The next time you play, a card back will be selected 
at random. If you have no other special settings selected in Solitaire, it's easier just to
delete the entire SOL.INI file instead of editing it, because BACK= will be the only 
entry in the file. Windows will recreate the SOL.INI file the next time you play 
Solitaire.

Quick Stacks
It gets tedious dragging a card from its row to the correct upper stack, especially if 
you're having a successful game where suit stacks are quickly building up. Well, you 
don't have to drag any more; double-click instead. When you turn over a card that 
belongs in one of the four stacks, simply double-clicking on it will send it to the 
correct destination. This saves time too!

No Missed Opportunities 
There's no way to guarantee you'll win at the Solitaire game included with Windows, 
but you increase your chances by using the Drag feature. Select Options from 
Solitaire's Game menu and choose Outline dragging. With this option turned on, 
moving a card over a stack that the card can legally be placed on causes that stack 
to change to an outline image.

To make sure you don't miss any moves that might help you, keep Outline 
dragging turned on. Every time you flip over a new card, pick it up and sweep across 
all the stacks. You'll easily spot any opportunities you might have missed. It's a good 
idea too, from time to time, to pick up the cards already placed on stacks and sweep 
them across the other stacks to make sure some opportunities haven't appeared 
during the game.

Cheating to Get the Card You Need
Suppose you're approaching the end of a game and you need a particular card. You 
click on the deck to draw three cards. The card you need is the second one down, but
you can't move the top card to get to it.

You know you can't go to Options and choose Draw One because it blows your 
game: Solitaire will redeal the cards. Instead, click Undo to return the three cards to 
the deck; then hold down Ctrl+Alt+Shift and click the deck again. Only one card turns
over! As long as you hold down those three keys you can go through the deck one 
card at a time!

Keyboard Shortcuts for Windows Accessories
The keyboard shortcuts that you can use with most of the Windows Accessories are 
shown in Table 6.9. 

TABLE 6.9 Keyboard Shortcuts for Windows Accessories

Key Action



F1 Displays context-sensitive help

Alt+F, N File, New

Alt+F, O File, Open

Alt+F, S File, Save

Alt+F, A File, Save As

Alt+F, P File, Print

Alt+F, X Close file and exit accessory

Ctrl+C Copies material to Clipboard

Ctrl+V Pastes material from Clipboard

Ctrl+X Cuts material to Clipboard

With the Alt-key combinations, you can first press Alt and then press the two 
letters, one after another. You needn't press the keys simultaneously.


